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Troubleshooting
This Chapter provides solutions to problems that can occur during the installation and 
operation of the DI-524 Wireless Broadband Router. We cover various aspects of the 
network setup, including the network adapters. Please read the following if you are 
having problems.

Note: If you have 
changed the default IP 
Address, make sure to 
ping the correct IP Ad-
dress assigned to the 
DI-524.

Note:  It is recommended that you use an Ethernet connection to 
configure the DI-524 Wireless Broadband Router.

  

1. The computer used to configure the DI-524 cannot access the  
   Configuration menu.

 Check that the Ethernet LED on the DI-524 is ON. If the LED is not 
ON, check that the cable for the Ethernet connection is securely 
inserted.

 Check that the Ethernet Adapter is working properly.  Please see 
item 3  (Check that the drivers for the network adapters are 
installed properly) in this Troubleshooting section to check that 
the drivers are loaded properly.

 Check that the IP Address is in the same range and subnet as the 
DI-524.  Please see Checking the IP Address in Windows XP in 
the Networking Basics section of this manual.

Note:  The IP Address of the DI-524 is 192.168.0.1.  All the computers on the 
network must have a unique IP Address in the same range, e.g., 192.168.0.x.  
Any computers that have identical IP Addresses will not be visible on the 
network.  They must all have the same subnet mask, e.g., 255.255.255.0

 Do a Ping test to make sure that the DI-524 is responding.  Go to 
Start>Run>Type Command>Type ping 192.168.0.1.  A successful 
ping will show four replies.
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2. The wireless client cannot access the Internet in the                      
 
    Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access 
Point. To check this connection:  Right-click on the Local Area Connection 
icon in the taskbar> select View Available Wireless Networks. The Connect to 
Wireless Network screen will appear.  Please make sure you have selected the 
correct available network, as shown in the illustrations below.

Troubleshooting

Check that the IP Address assigned to the wireless adapter is within 
the same IP Address range as the access point and gateway. (Since 
the  DI-524 has an IP Address of 192.168.0.1, wireless adapters must 
have an IP Address in the same range, e.g., 192.168.0.x.  Each device 
must have a unique IP Address; no two devices may have the same IP 
Address. The subnet mask must be the same for all the computers on 
the network.) To check the IP Address assigned to the wireless adapter, 
double-click on the Local Area Connection icon in the taskbar > 
select the Support tab and the IP Address will be displayed. (Please 
refer to Checking the IP Address in the Networking Basics section of 
this manual.)

If it is necessary to assign a Static IP Address to the wireless adapter, 
please refer to the appropriate section in Networking Basics. If you 
are entering a DNS Server address you must also enter the Default 
Gateway Address. (Remember that if you have a DHCP-capable router, 
you will not need to assign a Static IP Address.  See  Networking 
Basics: Assigning a Static IP Address.)
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Troubleshooting

3.  Check that the drivers for the network adapters are 
      installed properly.
You may be using different network adapters than those illustrated here, but this 
procedure will remain the same, regardless of the type of network adapters you are 
using.

Click Device 
Manager 

  Select the 
Hardware 
Tab

  

  Go to Start >   
My Computer > 
Properties
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Troubleshooting

  

  

  

  

  

Double-click 
on Network 
Adapters

Right-click on D-Link 
AirPlus DWL-G650 
Wireless Cardbus 
Adapter (In this example 
we use the DWL-G650; 
you may be using other 
network adapters, but 
the procedure will remain 
the same.) 

Select Proper-
ties to check that 
the drivers are 
installed properly

Look under Device 
Status to check that the 
device is working 
properly

Click OK

D-Link AirPlus DWL-G650

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter

D-Link AirPlus DWL-G650 Wireless Cardbus Adapter
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Troubleshooting

4.  What variables may cause my wireless products 
     to lose reception?
D-Link products let you access your network from virtually anywhere you want.  However, 
the positioning of the products within your environment will affect the wireless range.  
Please refer to Installation Considerations in the Wireless Basics section of this 
manual for further information about the most advantageous placement of your D-Link 
wireless products.

5.  Why does my wireless connection keep dropping?

6.  Why can’t I get a wireless connection?

If you have enabled Encryption on the DI-524, you must also enable encryption on all 
wireless clients in order to establish a wireless connection.

Make sure that the SSID on the Router and the Wireless Client are exactly the 
same.  If they are not, wireless connection will not be established. 

For 802.11b, the Encryption settings are: 64, 128, or 256 bit.  Make sure that 
the encryption bit level is the same on the Router and the Wireless Client.

  

  

Move the DI-524 and the wireless client into the same room and then test the 
wireless connection. 

 

Disable all security settings. (WEP, MAC Address Control) 

Antenna Orientation- Try different antenna orientations for the DI-524.  Try to 
keep the antenna at least 6 inches away from the wall or other objects.

  

If you are using 2.4GHz cordless phones, X-10 equipment or other home 
security systems, ceiling fans, and lights, your wireless connection will degrade 
dramatically or drop altogether.  Try changing the Channel on your Router, Access 
Point and Wireless adapter to a different Channel to avoid interference.

  

Keep your product away (at least 3-6 feet) from electrical devices that generate 
RF noise, like microwaves, Monitors, electric motors, etc.
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Troubleshooting

6.  Why can’t I get a wireless connection? (continued)
Turn off your DI-524 and the client. Turn the DI-524 back on again, and then 
turn on the client. 

 

Check that the LED indicators are indicating normal activity. If not, check that 
the AC power and Ethernet cables are firmly connected.

 

Make sure that all devices are set to Infrastructure mode.  

Check that the IP Address, subnet mask, gateway and DNS settings are cor-
rectly entered for the network. 

 

If you are using 2.4GHz cordless phones, X-10 equipment or other home se-
curity systems, ceiling fans, and lights, your wireless connection will degrade 
dramatically or drop altogether. Try changing the Channel on your DI-524, and 
on all the devices in your network to avoid interference.

 

Keep your product away (at least 3-6 feet) from electrical devices that generate 
RF noise, like microwaves, Monitors, electric motors, etc. 

 

7.  I forgot my encryption key.

Reset the DI-524 to its factory default settings and restore the other devices on 
your network to their default settings. You may do this by pressing the Reset 
button on the back of the unit. You will lose the current configuration settings. 
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8.  Resetting the DI-524 to Factory Default Settings
After you have tried other methods for troubleshooting your network, you may 
choose to Reset the DI-524 to the factory default settings.  Remember that 
D-Link AirPro products network together, out of the box, at the factory default 
settings.  

To hard-reset the DI-524 to Factory Default Settings, please do the following:

Troubleshooting

  

  

  

  After the DI-524 reboots (this may take a few minutes) 
it will be reset to the factory Default settings

Use a paper clip to press the Reset button

Hold for about 10 seconds and then release

Locate the Reset button on the back of the DI-524

Reset
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IP Filtering
URL Filtering
Domain Blocking
Scheduling

IEEE 802.11b 
IEEE 802.3
IEEE 802.3u

Technical Specifications

L2TP

 
 
 

Standards

VPN Pass Through/ Multi-Sessions
PPTP

Device Management
Web-Based- Internet Explorer v6 or later; Netscape Navigator v7 
or later; or other Java-enabled browsers

Advanced Firewall Features
NAT with VPN Passthrough (Network Address Translation)

 
 
 
 

 
 
 
 

 
 
 
 
 
 
 
 

95% maximum (non-condensing)

Wireless Operating Range  

 

Operating Temperature
         32ºF to 131ºF (0ºC to 55ºC)
         
 

 

Humidity:
 

 
  Indoors – up to 328 feet (100 meters) 

 IPSec

 DHCP Server and Client

 MAC Filtering

  Outdoors – up to 984 feet (300 meters) 

Safety and Emissions:
FCC, CE 

 IEEE 802.11g

2.4GHz to 2.462GHz 

Wireless Frequency Range:
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LEDs:
Power
WAN

Physical Dimensions:

Technical Specifications

 
 
 
 

L = 5.6 inches (142mm)
W = 4.3 inches (109mm)
H = 1.2 inches (31mm)

 
 
 

Wireless Transmit Power:
14dBm 

 
 
 

Security:
802.1x
WEP 

 WPA
 WPA-PSK

 
 

 

External Antenna Type:

Single detachable reverse SMA 
 

Orthogonal Frequency Division Multiplexing (OFDM)
Modulation Technology:

 

 
 

Power Input:
Ext. Power Supply DC 7.5V, 1.5A

Weight:

0.44 lbs. (200g) 

 

LAN (10/100)
WLAN (Wireless Connection)

 
 
 
 

 

Warranty:

1 year 
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54 Mbps
48 Mbps
36 Mbps
24 Mbps
18 Mbps
12 Mbps
11 Mbps
9 Mbps
6 Mbps
5.5 Mbps
2 Mbps
1 Mbps

Wireless Data Rates with Automatic Fallback:   
 
 
 

 

 

 
 

 
 

 
 
 

54Mbps OFDM, 10% PER, -68dBm
48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm

 
 
 

Receiver Sensitivity:

24Mbps OFDM, 10% PER, -79dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm

 
 
 

11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps  QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm

 
 
 
 

Technical Specifications
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Frequently Asked Questions

  

 
 
When entering the IP Address of the DI-524  (192.168.0.1), you are not connecting to 
the Internet or have to be connected to the Internet. The device has the utility built-in 
to a ROM chip in the device itself. Your computer must be on the same IP subnet to 
connect to the web-based utility.  
 
To resolve difficulties accessing a  web utility, please follow the steps below.  

Step 1 Verify physical connectivity by checking for solid link lights on the device. 
If you do not get a solid link light, try using a different cable or connect to a different 
port on the device if possible. If the computer is turned off, the link light may not be 
on. 
 

 
 
 
 

The following connections require a Crossover Cable: 
Computer to Computer 
Computer to Uplink Port 
Computer to Access Point 
Computer to Print Server 
Computer/XBOX/PS2 to DWL-810 
Computer/XBOX/PS2 to DWL-900AP+ 
Uplink Port to Uplink Port (hub/switch) 
Normal Port to Normal Port (hub/switch) 
 
The following connections require a Straight-through Cable: 
Computer to Residential Gateway/Router 
Computer to Normal Port (hub/switch) 
Access Point to Normal Port (hub/switch) 
Print Server to Normal Port (hub/switch) 
Uplink Port to Normal Port (hub/switch) 
 
Rule of Thumb: 
”If there is a link light, the cable is right.” 
 
 
 

What type of cable should I be using?

Why can´t I access the web based configuration?
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Frequently Asked Questions (continued)

What type of cable should I be using? (continued)
What´s the difference between a crossover cable and a straight-through 
cable?  
The wiring in crossover and straight-through cables are different. The two 
types of cable have different purposes 
for different LAN configurations. EIA/TIA 
568A/568B define the wiring standards 
and allow for two different wiring color 
codes as illustrated in the following 
diagram. 
 *The wires with colored backgrounds may 
have white stripes and may be denoted 
that way in diagrams found elsewhere.

How to tell straight-through cable from 
a crossover cable: 
The main way to tell the difference 
between the two cable types is to 
compare the wiring order on the ends 
of the cable. If the wiring is the same on 
both sides, it is straight-through cable. If one side has opposite wiring, it is a 
crossover cable.
 
All you need to remember to properly configure the cables is the pinout order of 
the two cable ends and the following rules: 
A straight-through cable has identical ends 
A crossover cable has different ends
 
It makes no functional difference which standard you follow for straight-through 
cable ends, as long as both ends are the same. You can start a crossover cable 
with either standard as long as the other end is the other standard. It makes no 
functional difference which end is which. The order in which you pin the cable 
is important. Using a pattern other than what is specified in the above diagram 
could cause connection problems.
 
When to use a crossover cable and when to use a straight-through cable: 
Computer to Computer – Crossover 
Computer to an normal port on a Hub/Switch – Straight-through 
Computer to an uplink port on a Hub/Switch - Crossover 
Hub/Switch uplink port to another Hub/Switch uplink port – Crossover 
Hub/Switch uplink port to another Hub/Switch normal port - Straight-through 
 
 

Why can´t I access the web based configuration? (continued)
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Step 3 Configure your Internet settings.  
 

Step 2  Disable any Internet security software running on the computer. Software 
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might 
block access to the configuration pages. Check the help files included with your 
firewall software for more information on disabling or configuring it. 

Frequently Asked Questions (continued)

Click to the Connection tab and set the dial-
up option to Never Dial a Connection. Click 
the LAN Settings button

Nothing should be checked. Click OK

Go to the Advanced tab and click the 
button to restore these settings to their 
defaults

Click OK. Go to the desktop and close any open 
windows

Go to Start>Settings>Control Panel. Double 
click the Internet Options Icon. From the Security 
tab, click the button to restore the settings to their 
defaults. 

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the 
same range of the device you are attempting to configure. Most D-Link devices use 
the 192.168.0.X range. 
 

How can I find my IP Address in Windows 95, 98, or 
ME?  
Step 1 Click on Start, then click on Run.  
 
Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as 
shown then click OK.  
 

Step 3 The IP Configuration window will appear, displaying your Ethernet 
Adapter Information.  
 
 

 Select your adapter from the drop down menu. 
 If you do not see your adapter in the drop down menu, your adapter is   
     not properly installed. 

Step 4   After selecting your adapter, it will display your IP Address, subnet 
mask, and default gateway.  
Step 5  Click OK to close the IP Configuration window

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address 
in the same range of the device you are attempting to configure. Most D-Link devices 
use the 192.168.0.X range. 
 

How can I find my IP Address in Windows 2000/XP?  
 

Step 1 Click on Start and select Run.  
 
Step 2 Type cmd then click OK.  
 

Step 3 From the Command Prompt, enter ipconfig. It will return your IP 
Address, subnet mask, and default gateway

Step 4 Type exit to close the command prompt. 
 
 
 

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

Step 4  (continued) Check your IP Address. Your computer must have an IP 
Address in the same range of the device you are attempting to configure. Most D-
Link devices use the 192.168.0.X range. 
 Make sure you take note of your computer´s Default Gateway IP Address. The 
Default Gateway is the IP Address of the D-Link router. By default, it should be 
192.168.0.1.  
 

How can I assign a Static IP Address in Windows XP?  
 
 
 
 

Step 1  
Click on Start > Control Panel > Network and Internet Connections > 
Network connections.  
 
Step 2 See Step 2 for Windows 2000 and continue from there.

How can I assign a Static IP Address in Windows 2000?  
 
 
 
 

Step 1 Right-click on My Network 
Places and select Properties.  
 Step 2 Right-click on the Local 
Area Connection which represents 
your network card and select 
Properties.  
 

Highlight Internet Protocol (TCP/
IP) and click Properties.

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

How can I assign a Static IP Address in Windows 
2000? (continued)  
 
 
 
 

Click Use the following IP Address and 
enter an IP Address that is on the same 
subnet as the LAN IP Address on your 
router. Example: If the router´s LAN IP 
Address is 192.168.0.1, make your IP 
Address 192.168.0.X where X = 2-99. 
Make sure that the number you choose 
is not in use on the network.  
 
Set the Default Gateway to be the 
same as the LAN IP Address of your 
router (192.168.0.1).  
 
Set the Primary DNS to be the same 
as the LAN IP address of your router 
(192.168.0.1).  
 
The Secondary DNS is not needed or enter a DNS server from your ISP.  
 
Click OK twice. You may be asked if you want to reboot your computer. Click 
Yes.  
 
 How can I assign a Static IP 
Address in Windows 98/Me?  
 
Step 1 From the desktop, right-click on the 
Network Neigborhood icon (Win ME - My 
Network Places) and select Properties
 
 
 
Highlight TCP/IP and click the Properties 
button. If you have more than 1 adapter, 
then there will be a TCP/IP “Binding” 
for each adapter. Highlight TCP/IP > 
(your network adapter) and then click 
Properties.  
 

Why can´t I access the web based configuration? (continued)
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Frequently Asked Questions (continued)

How can I assign a Static IP Address in 
Windows 98/Me? (continued)
Step 2 Click Specify an IP Address.  
 
 
 

Step 3 Click on the Gateway tab.  
 Enter the LAN IP Address of your router 

here (192.168.0.1).

Click Add when finished.  
 

Step 4 Click on the DNS Configuration tab.  

Enter in an IP Address that is on the same 
subnet as the LAN IP Address on your 
router. Example: If the router´s LAN IP 
Address is 192.168.0.1, make your IP 
Address 192.168.0.X where X is between 
2-99. Make sure that the number you choose 
is not in use on the network. 

 
Step 5 Click OK twice.  
 

Click Enable DNS. Type in a Host (can 
be any word). Under DNS server search 
order, enter the LAN IP Address of your 
router (192.168.0.1). Click Add.  

When prompted to reboot your computer, 
click Yes.  
After you reboot, the computer will now 
have a static, private IP Address. 

Why can´t I access the web based configuration? (continued)

Step 5 Access the web management. Open your web 
browser and enter the IP Address of your D-Link device in 
the address bar. This should open the login page for the 
web management. Follow instructions to login and complete the configuration.  
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Frequently Asked Questions (continued)

How can I setup my router to work with a Cable modem connection?

Dynamic Cable connection
 (IE AT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).  

 
Note: Please configure the router with the computer that was last connected directly 
to the cable modem.  
 Step 1 Log into the web based configuration by typing in the IP Address of the 
router (default:192.168.0.1) in your web browser. The username is admin (all 
lowercase) and the password is blank (nothing).  

Step 2 Click the Home tab and click the 
WAN button. Dynamic IP Address is the 
default value, however, if Dynamic IP Address 
is not selected as the WAN type, select 
Dynamic IP Address by clicking on the radio 
button. Click Clone Mac Address. Click 
on Apply and then Continue to save the 
changes.  
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Frequently Asked Questions (continued)

How can I setup my router to work with a Cable modem connection? 
(continued)

Step 3 Power cycle the cable modem and router:  
 
Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.** 
Turn the cable modem on (first).  Wait until you get a solid cable light on the cable 
modem. Turn the router on. Wait 30 seconds.  
 
** If you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.  
 
Step 4 Follow step 1 again and log back into the web configuration. Click the 
Status tab and click the Device Info button. If you do not already have a public IP 
Address under the WAN heading, click on the DHCP Renew and Continue buttons.  

Static Cable Connection
Step 1 Log into the web based configuration 
by typing in the IP Address of the router 
(default:192.168.0.1) in your web browser. The 
username is admin (all lowercase) and the 
password is blank (nothing). 

Step 2 Click the Home tab and click the WAN 
button. Select Static IP Address and enter your 
static settings obtained from the ISP in the fields 
provided.  
 
If you do not know your 
settings, you must contact 
your ISP. 

Step 3 Click on Apply and 
then click Continue to save 
the changes.  
 
Step 4 Click the Status 
tab and click the Device 
Info button. Your IP Address 
information will be displayed 
under the WAN heading.  
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Frequently Asked Questions (continued)

How can I setup my router to work with Earthlink DSL or any PPPoE 
connection? 

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet 
300 from your computer or you will not be able to connect to the Internet.  
 
Step 1 Upgrade Firmware if needed.  
 
(Please visit the D-Link tech support website at: http://support.dlink.com for the latest 
firmware upgrade information.) 
 
Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip 
and hold down the reset button on the back of the unit for 10 seconds. Release it and 
the router will recycle, the lights will blink, and then stabilize.  
 
Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into 
the address window and hit the Enter key. When the password dialog box appears, 
enter the username admin and leave the password blank. Click OK.  
 
If the password dialog box does not come up repeat Step 2.  
 
Note: Do not run Wizard.  
 
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.  
 
Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP 
Address).  
 
Step 6 In the username field enter ELN/username@earthlink.net and your 
password, where username is your own username.  
 
For SBC Global users, enter username@sbcglobal.net. 
For Ameritech users, enter username@ameritech.net. 
For BellSouth users, enter username@bellsouth.net. 
For Mindspring users, enter username@mindspring.com. 
For most other ISPs, enter username.  
 
Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless 
specified by your ISP, and set Autoreconnect to Enabled.  
 
Note: If you experience problems accessing certain websites and/or email issues, 
please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for 
more information and the proper MTU setting for your connection.  
 
 



76

 
Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes, 
unplug the power to the D-Link router.  
 
Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem 
has established a link to your ISP, plug the power back into the D-Link router. Wait 
about 30 seconds and log back into the router.  
 
Step 10 Click on the Status tab in the web configuration where you can view the 
device info. Under WAN, click Connect. Click Continue when prompted. You should 
now see that the device info will show an IP Address, verifying that the device has 
connected to a server and has been assigned an IP Address. 

How can I setup my router to work with Earthlink DSL or any PPPoE 
connection? (continued)

Frequently Asked Questions (continued)

Can I use my D-Link Broadband Router to share my Internet connection 
provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the 
client software. If this is the case, then our routers will work with this service. Please 
contact AOL if you are not sure. 
 
To set up your router:  
 
Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN 
side to use PPPoE.  
 
Step 2 Enter your screen name followed by @aol.com for the user name. Enter 
your AOL password in the password box.  
 
Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything 
higher than 1400.  
 
Step 4 Apply settings.  
 
Step 5 Recycle the power to the modem for 1 minute and then recycle power to the 
router. Allow 1 to 2 minutes to connect.  
 
If you connect to the Internet with a different internet service provider and want 
to use the AOL software, you can do that without configuring the router’s firewall 
settings. You need to configure the AOL software to connect using TCP/IP. 
Go to http://www.aol.com for more specific configuration information of their software. 
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Frequently Asked Questions (continued)

How do I open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up 
ports or the router will block the request.  
 
Step 1 Open your web 
browser and enter the IP 
Address of your D-Link router 
(192.168.0.1). Enter username 
(admin) and your password 
(blank by default).  
 
Step 2 Click on Advanced 
on top and then click Virtual 
Server on the left side.  

Step 3 Check Enabled to 
activate entry.  
 
Step 4 Enter a name for your virtual server entry.  
 
Step 5 Next to Private IP, enter the IP Address of the computer on your local 
network that you want to allow the incoming service to.  
 
Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select 
both.  
 
Step 7 Enter the port information next to Private Port and Public Port. The private 
and public ports are usually the same. The public port is the port seen from the WAN 
side, and the private port is the port being used by the application on the computer 
within your local network.  
 
Step 8 Enter the Schedule information.  
 
Step 9 Click Apply and then click Continue.  
 
Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual 
Server entries.  
 
Because our routers use NAT (Network Address Translation), you can only open a 
specific port to one computer at a time. For example: If you have 2 web servers on 
your network, you cannot open port 80 to both computers. You will need to configure 
1 of the web servers to use port 81. Now you can open port 80 to the first computer 
and then open port 81 to the other computer.  
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:  
In computer networks, a DMZ (demilitarized zone) is a computer host or small 
network inserted as a neutral zone between a company´s private network and the 
outside public network. It prevents outside users from getting direct access to a 
server that has company data. (The term comes from the geographic buffer zone 
that was set up between North Korea and South Korea following the UN police action 
in the early 1950s.) A DMZ is an optional and more secure approach to a firewall and 
effectively acts as a proxy server as well.  
 
In a typical DMZ configuration for a small company, a separate computer (or host in 
network terms) receives requests from users within the private network for access 
to Web sites or other companies accessible on the public network. The DMZ host 
then initiates sessions for these requests on the public network. However, the DMZ 
host is not able to initiate a session back into the private network. It can only forward 
packets that have already been requested.  
 
Users of the public network outside the company can access only the DMZ host. The 
DMZ may typically also have the company´s Web pages so these could be served 
to the outside world. However, the DMZ provides access to no other company data. 
In the event that an outside user penetrated the DMZ hosts security, the Web pages 
might be corrupted but no other company information would be exposed. D-Link, a 
leading maker of routers, is one company that sells products designed for setting up 
a DMZ

How do I configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the 
local network. The DMZ, or Demilitarized Zone, will allow the specified computer 
to be exposed to the Internet. DMZ is useful when a certain application or game 
does not work through the firewall. The computer that is configured for DMZ will be 
completely vulnerable on the Internet, so it is suggested that you try opening ports 
from the Virtual Server or Firewall settings before using DMZ. 
 
 
Step 1 Find the IP address of the computer you want to use as the DMZ host.  
 
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x 
or Macintosh operating systems please refer to Step 4 of the first question in this 
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

Step 2 Log into the web based configuration 
of the router by typing in the IP Address 
of the router (default:192.168.0.1) in your 
web browser. The username is admin (all 
lowercase) and the password is blank 
(nothing)  
 

How do I configure the DMZ Host? (continued)

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable 
and type in the IP Address you found in step 1. 

Step 4 Click Apply 
and then Continue to 
save the changes.  
 
Note: When DMZ is 
enabled, Virtual Server 
settings will still be 
effective. Remember, 
you cannot forward the 
same port to multiple 
IP Addresses, so the 
Virtual Server settings 
will take priority over 
DMZ settings.  
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Frequently Asked Questions (continued)

How do I open a range of ports on my DI-524 using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in 
your web browser. The default IP Address is 192.168.0.1. Login using your password. 
The default username is “admin” and the password is blank.  
 If you are having difficulty accessing web management, please see the first question 
in this section.
Step 2 From the web management Home page, click the Advanced tab then click 
the Firewall button.  
 

  
 

Step 3 Click on 
Enabled and type in a 
name for the new rule.  
 
Step 4 Choose WAN 
as the Source and 
enter a range of IP 
Addresses out on the 
internet that you would 
like this rule applied 
to. If you would like 
this rule to allow all 
internet users to be 
able to access these 
ports, then put an 
Asterisk in the first 
box and leave the 
second box empty.  
 

Step 5 Select LAN as the Destination and enter the IP Address of the computer on 
your local network that you want to allow the incoming service to. This will not work 
with a range of IP Addresses.  
 Step 6 Enter the port or range of ports that are required to be open for the incoming service.  
 
Step 7 Click Apply and then click Continue. 
 
 
Because our routers use NAT (Network Address Translation), you can only open a 
specific port to one computer at a time. For example: If you have 2 web servers on 
your network, you cannot open port 80 to both computers. You will need to configure 
1 of the web servers to use port 81. Now you can open port 80 to the first computer 
and then open port 81 to the other computer.  
 

Note: Make sure DMZ host is disabled. 
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Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be 
redirected to the computer specified by the server IP. For example, if you have an 
FTP Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and 
a VPN server at 192.168.0.7, then you need to specify the following virtual server 
mapping table: 
 

Server Port Server IP Enable

  21        192.168.0.5  X

80      192.168.0.6          X

1723        192.168.0.7  X

How do I use PC Anywhere with my DI-524 router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.  
 
Step 1 Open your web browser and enter the IP Address of the router 
(192.168.0.1).  
 
Step 2 Click on Advanced at the top and then click Virtual Server on the left side.  
 
Step 3 Enter the 
information as seen 
below. The Private IP 
is the IP Address of the 
computer on your local 
network that you want 
to connect to. 

Step 4 The first entry 
will read as shown here: 

Step 5 Click Apply 
and then click Continue. 
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How do I use PC Anywhere with my DI-524 router? (continued)

Frequently Asked Questions (continued)

Step 6 Create 
a second entry 
as shown here: 

Step 7 Click 
Apply and then 
click Continue.  
 

Step 8 Create 
a third and final 
entry as shown 
here: 

Step 9 Click Apply and then click Continue.  
 
Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the 
router, not your computer´s IP Address.  
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How can I use eDonkey behind my D-Link Router?

Frequently Asked Questions (continued)

You must open ports on your router to allow incoming traffic while using eDonkey.  
 
eDonkey uses three ports (4 if using CLI): 

4661 (TCP) To connect with a server 
4662 (TCP) To connect with other clients 
4665 (UDP) To communicate with servers other than the one you are connected to. 
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow 
remote connections. This is the case when using a Graphical Interface (such as the 
Java Interface) with the client.  
 Step 1 Open your web browser and enter the IP Address of your router 
(192.168.0.1). Enter username (admin) and your password (leave blank).  
 
Step 2 Click on Advanced and then click Firewall.  
 
Step 3 Create a 
new firewall rule: 
Click Enabled. 
Enter a name 
(edonkey). 
Click Allow. 
Next to Source, 
select WAN under 
interface. In the 
first box, enter an *. 
Leave the second 
box empty. 
Next to Destination, 
select LAN under 
interface. Enter the 
IP Address of the 
computer you are 
running eDonkey 
from. Leave the 
second box empty. 
Under Protocol, 
select *. In the port range boxes, enter 4661 in the first box and then 4665 in the 
second box. Click Always or set a schedule. 

Step 4 Click Apply and then Continue.  
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Frequently Asked Questions (continued)

To allow you to play SOCOM and hear audio, you must download the latest firmware 
for the router (if needed), enable Game Mode, and open port 6869 to the IP Address 
of your Playstation.  
 Step 1 Upgrade firmware (follow link above).  
 
Step 2 Open your web browser and enter the IP Address of the router 
(192.168.0.1). Enter username (admin) and your password (blank by default).  
 
Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.  
 
Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a 
name (socom). Enter the IP Address of your Playstation for Private IP.  
 
Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and 
Public Port. Click Always. Click Apply to save changes and then Continue

Step 6 Click on the Tools tab and then Misc on the left side.  
 
Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply and 
then Continue.  
 
 
 

How do I set up my router for SOCOM on my Playstation 2?
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Frequently Asked Questions (continued)

How can I use Gamespy behind my D-Link router?

Step 1 Open your web browser and enter the IP Address of the router 
(192.168.0.1). Enter admin for the username and your password (blank by default).  

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.  
 
Step 3 You will create 2 entries.  
 
Step 4 Click Enabled and enter Settings: 

 
 

Click Apply and then continue

Step 5 Enter 2nd entry: 
        Click Enabled 

 
Click Apply and then continue.  
 

NAME - Gamespy1 

PRIVATE IP - The IP Address 
of your computer that you are 
running Gamespy from. 

PROTOCOL TYPE - Both 

PRIVATE PORT - 3783 

PUBLIC PORT - 3783 

SCHEDULE - Always. 

NAME - Gamespy2 

PRIVATE IP - The IP Address 
of your computer that you  
are running Gamespy from. 

PROTOCOL TYPE - Both 

PRIVATE PORT - 6500 

PUBLIC PORT - 6500 

SCHEDULE - Always. 
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Frequently Asked Questions (continued)

How do I configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing 
system.  
 
In most cases, you do not have to configure anything on the router or on the Kazaa 
software. If you are having problems, please follow steps below:  
 
Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).  
 
Step 2 Enter your username (admin) and your password (blank by default).  
 
Step 3 Click on Advanced and then click Virtual Server.  
 
Step 4 Click Enabled and then enter a Name (kazaa for example).  
 
Step 5 Enter the IP Address of the computer you are running KaZaA from in the 
Private IP box. Select TCP for the Protocol Type.  
 
Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under 
schedule or set a time range. Click Apply. 

Make sure that you did not enable proxy/firewall in the KaZaA software.  
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Frequently Asked Questions (continued)

How do I configure my router to play  Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in 
Warcraft 3. To play a game, you do not have to configure your router.  
 
Warcraft 3 (Battlenet) uses port 6112.  
 
For the DI-604, DI-614+. DI-524, 
DI-754, DI-764, or DI-774:  
 
Step 1 Open your web browser 
and enter the IP Address of 
your router (192.168.0.1). Enter 
username (admin) and your 
password (leave blank).  
 
Step 2 Click on Advanced and 
then click Virtual Server.  
 
Step 3 Create a new entry: 
Click Enabled. Enter a name 
(warcraft3). Private IP - Enter the 
IP Address of the computer you 
want to host the game. Select 
Both for Protocol Type Enter 6112 for both Private Port and Public Port Click Always 
or set a schedule.  
 

Step 4 Click Apply and then Continue.  
 
Note: If you want multiple computers from you LAN to play in the same game that 
you are hosting, then repeat the steps above and enter the IP Addresses of the other 
computers. You will need to change ports. Computer #2 can use port 6113, computer 
#3 can use 6114, and so on.  
 
You will need to change the port information within the Warcraft 3 software for 
computers #2 and up. 
 
Configure the Game Port information on each computer:  
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you 
should see Game Port. Enter the port number as you entered in the above steps.  
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Frequently Asked Questions (continued)

How do I use NetMeeting with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of 
STATIC PORTS. That means that each NetMeeting connection is somewhat different 
than the last. For instance, the HTTP web site application uses port 80. NetMeeting 
can use any of over 60,000 different ports.  
 
All broadband routers using (only) standard NAT and all internet sharing programs 
like Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or 
other h.323 software packages.  
 
The solution is to put the router in DMZ.  
 
Note: A few hardware manufacturers have taken it on themselves to actually provide 
H.323 compatibility. This is not an easy task since the router must search each 
incoming packet for signs that it might be a netmeeting packet. This is a whole lot 
more work than a router normally does and may actually be a weak point in the 
firewall. D-Link is not one of the manufacturers. 
 
To read more on this visit http://www.HomenetHelp.com  
 

How do I set up my router to use iChat?  -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.  
 
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403 
(UDP) To video conference with other clients  
 
 
Step 1 Open your web browser and enter the IP Address of your router 
(192.168.0.1). Enter username (admin) and your password (leave blank).  
 
Step 2 Click on Advanced and then click Firewall.  
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Frequently Asked Questions (continued)

Step 3 Create a new firewall rule: 

Leave the second box empty. Under  Protocol, select UDP. In the port range boxes, 
enter 5060 in the first box and leave the second box empty. 
Click Always or set a schedule. 

Step 4 Click Apply 
and then Continue. 

 
 
Step 5 
Repeat steps 3 and 4 
enter ichat2 and open 
ports 16384-16403 
(UDP). 

How do I set up my router to use iChat? -for Macintosh users- 
(continued)

Click Enabled. 
Enter a name 
(ichat1). 
Click Allow. 
Next to Source, 
select WAN under 
interface.
In the first box, 
enter an *.
Leave the second 
box empty. 
Next to Destination, 
select LAN under 
interface. 
Enter the IP 
Address of the 
computer you are running iChat from. 
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Frequently Asked Questions (continued)

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in 
the Sharing preference pane on both computers. 
To use the Mac OS X Firewall, you must open the same ports as in the router:  

Step 1 Choose Apple menu > System Preferences. 
Step 2 Choose View > Sharing. 
Step 3 Click the Firewall tab.
Step 4 Click New. 
Step 5 Choose Other from the Port Name pop-up menu.
Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403. 
Step 7 In the Description field type in: iChat AV 
Step 8 Click OK. 

For File Sharing:  
Step 1 Click on 
Advanced and then 
Virtual Server.  
 
Step 2 Check Enabled 
to activate entry.  
 
Step 3 Enter a name for 
your virtual server entry 
(ichat3).  
 
Step 4 Next to Private 
IP, enter the IP Address 
of the computer on 
your local network that 
you want to allow the 
incoming service to.  
 
Step 5 Select TCP for 
Protocol Type.  
 
Step 6 Enter 5190 next to Private Port and Public Port.  
 
Stsp 7 Click Always or configure a schedule.  
 
Step 8 Click Apply and then Continue.  
 

How do I set up my router to use iChat? -for Macintosh users- 
(continued)
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Frequently Asked Questions (continued)

How do I send or receive a file via iChat when the Mac OSX firewall is 
active? -for Macintosh users- Mac OS X 10.2 and later

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default 
state. If you have opened the AIM port, you may be able to receive a file but not send 
them. 

In its default state, the Mac OS X firewall blocks file transfers using iChat or America 
Online AIM software. If either the sender or receiver has turned on the Mac OS X fire-
wall, the transfer may be blocked. 

The simplest workaround is to temporarily turn off the firewall in the Sharing preference 
pane on both computers. This is required for the sender. However, the receiver may 
keep the firewall on if the AIM port is open. To open the AIM port:

If you do not want to turn off the firewall at the sending computer, a different file sharing 
service may be used instead of iChat. The types of file sharing available in Mac OS X 
are outlined in technical document 106461, “Mac OS X: File Sharing” in the AppleCare 
Knowledge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click 
the Firewall tab and select the service you have chosen in the “Allow” list. If you do not 
do this, the firewall will also block the file sharing service. “

The following information is from the online Macintosh AppleCare knowledge base:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5  Choose AOL IM from the Port Name pop-up menu. The number 
5190 should already be filled in for you.

Step 6 Click OK.
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What is NAT?

NAT stands for Network Address Translator. It is proposed and described in 
RFC-1631 and is used for solving the IP Address depletion problem. Basically, each 
NAT box has a table consisting of pairs of local IP Addresses and globally unique 
addresses, by which the box can “translate” the local IP Addresses to global address 
and vice versa. Simply put, it is a method of connecting multiple computers to the 
Internet (or any other IP network) using one IP Address.  
 
D-Link´s broadband routers (ie: DI-604) support NAT. With proper configuration, 
multiple users can access the Internet using a single account via the NAT device. 
 
For more information on RFC-1631: The IP Network Address Translator (NAT), visit 
http://www.faqs.org/rfcs/rfc1631.html 
 

Frequently Asked Questions (continued)



NOTE:THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY RADIO OR 
TV INTERFERENCE CAUSED BY UNAUTHORIZED MODIFICATIONS TO 
THIS EQUIPMENT. SUCH MODIFICATIONS COULD VOID THE USER’S 
AUTHORITY TO OPERATE THE EQUIPMENT. 
 
FCC RF exposure requirements:  The antenna used for this transmitter must be 
installed to provide a separation distance of at least 20 cm from all persons and must 
not be co-located or operating in conjunction with any other antenna or transmitter. 
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Features List: 
1. Integrate with 4 ports Fast Ethernet switch: 10/100Mbps MDI/MDIX auto-sensing. 
2. Provide 10/100Mps WAN interface to connect with DSL or cable modem for broadband 

Internet access. 
3. Built-in NAT function: allow multiple PCs and devices to share one Internet connection. 
4. Over 90Mbps wired routing speed. 
5. Browser-based interface configuration and management: OS independent, easy-to-use 

for consumer install. 
6. Built-in firewall to protect your Intranet. 
7. VPN support: pass through of PPTP, L2TP, and IPSec. 
8. Easy to upgrade: using Web or Windows Application to upgrade new version of 

firmware. 
9. High speed for wireless LAN connection: support both IEEE 802.11b and 802.11g. Up 

to 54 Mbps data rate when operates in 802.11g mode. 
10. Provide seamless roaming within the IEEE 802.11b and 802.11g WLAN infrastructure. 
11. Data rate supported: 6/12/18/24/36/48/54 Mbps in 802.11g mode; 1/2/5.5/11Mbps in 

802.11b mode. 
12. WEP encryption and WPA supported. 

 

Block Diagram: 
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Specification Tables: 
 

Hardware and Port Characteristic 
CPU DL7500 
Memory Flash 1MB, DRAM 2MB 
LAN Port 4 x RJ45, 10/100 Mbps with Auto-MDI/MDIX 
WAN Port 1 x RJ45, 10/100 Mbps with Auto-MDI/MDIX 
Input Power DC 7.5V/1.5A 

Operational & Functional Characteristic 
Firmware Platform AMIT Proprietary Kernel 
Management Method Web-based 

Static IP Address 
Dynamic IP Address (DHCP Client) 
PPP over Ethernet 
Multi-session PPP over Ethernet (For Japan only) 
PPTP 

Supported WAN Type 

L2TP 
Connect on Demand / Auto-Disconnect 
Manually Connect/Disconnect Connection Scheme 
Auto Reconnect 
One-to-Many NAT 
One-to-One NAT 
Virtual Server 
Special Application 

NAT Functionality 

DMZ Host 
MAC-level Access Control 
Inbound/Outbound IP Filter Access Control 
Domain Access Control 
NAT Firewall with SPI mode 

Firewall 
DoS Detection 
On-web logging 
Syslog supported Event Logging 
Email Alert 

VPN Supporting IPSec, PPTP, LT2P Pass-Through 
Routing Static Route 
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Web-based 
Upgrade Method 

Windows Application 
DDNS Supported 
UPnP Supported Other Features 
SNMP Supported 

Wireless Support 
Solution Ralink 802.11g on Board 
Standard IEEE 802.11b / 802.11g 

Data Rate* 
6/12/18/24/36/48/54Mbps in 802.11g mode 
1/2/5.5/11Mbps in 802.11b mode 

Operating Frequency 2.4GHz 

Range Coverage 
Per cell indoors approx. 35-100 meters 
Per cell outdoors up to 100-300 meters 

Antenna 2 dBi dipole antenna x 1 

Number of Channels 
America/ FCC: 2.412~2.462GHz (11 Channels) 
Japan/ TELEC: 2.412~2.484GHz (14 Channels) 
Europe/ ETSI: 2.412~2.472GHz (13 Channels) 

Security WEP encryption and WPA supported 
Environment, Certification and Reliability 

Operating Temperature Temperature: 0~40oC, Humidity 10%~90% non-condensing 
Storage Temperature Temperature: -20~70oC, Humidity: 0~95% non-condensing 
EMC/Safety FCC, CE 
Reliability Stress Test; Vibration Test; Drop Test 
 
* Maximum wireless signal rate based on IEEE 802.11 series standard specifications. Actual data throughput will vary. 

Network conditions and environmental factors lower actual data throughput rate. 

 




